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Abstrak: Penelitian ini berfungsi untuk menawarkan kemungkinan pmakaian audio sebagai 

alternatif pembelajaran. Dengan audio sebagai medianya seorang pengajar dapat 

mengenfisiensiakan kegiatan belajar mengajar. Selain itu, penelitian ini akan menjadi tawaran 

pembelajaran yang mengasilkan bagi siswa-siswi. Metode penelitian yang digunakan berupa 

metode kualitatif yang bersifat deskriptif dan cenderung menggunakan analisis. Analisis yang 

digunakan bertujuan untuk membandingkan aplikasi yang digunakan untuk pembelajaran 

istima’. Menganalisis bagaimana audio di produksi dan terdengar nyaman bagi siswa-siswi. 

Aplikasi ini merupakan apliksi berbasis teknologi. Audacity ini menyediakan ruang dalam 

pembelajaran. Fitur-fitur yang tersedia dalam aplikasi ini menyediakan berbagai efek untuk 

daya tarik peserta didik. 

Kata Kunci: Pemanfaatan; Aplikasi audicaty; Istima; Sungayang 

Abstract: This study serves to offer the possibility of using audio as a learning alternative. 

With audio as the medium, a teacher can streamline teaching and learning activities. In 

addition, this research will be an offer of profitable learning for students. The research 

method used is a qualitative method that is descriptive and tends to use analysis. The analysis 

used aims to compare the applications used for special learning'. Analyze how audio is 

produced and sounds comfortable for students. This application is a technology-based 

application. Audacity provides space for learning. The features available in this application 

provide various effects to attract students 

Keywords: Utilization; Audicaty application; Special; love 
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PENDAHULUAN 

Perkembangan teknologi saat ini yang sangat pesat bukan lagi hal yang mengejutkan 

didunia ini. Bahkan pada zaman 4.0 ini para peneliti berlomba-lomba untuk 

mengembangkan teknologi yang semakin modern 1.Membantu banyak orang untuk 

mendapatkan informasi dan mempermudah para orang-orang dalam melakukan 

aktivitasnya. Tidak jarang peneliti melakukan pembaruan dalam aplikasi yang telah ada 

dengan menambah fitur-fitur terbaru sehingga lebih canggih dan terlihat modern 2. 

Sebagaimana yang kita ketahui, bahwasannya negara kita saat ini mengalami 

perubahan, baik berasal segi ekonomi, sosial bahkan hingga pada jenjang pendidikan. 

Perubahan tersebut memunculkan berbagai problem, baik yang bersifat eksternal maupun 

internal 3. untuk menuntaskan permasalahan tersebut, tentunya tidak bisa diselaikan oleh 

sembarangan orang, hal itu bisa diselesaikan oleh orang yang cerdas, dan orang yang 

cerdas itu tentunya memiliki ilmu pengetahuan yang luas, yang diperoleh melalui proses 

pendidikan 4. 

Namun Pandemi COVID-19 saat ini merupakan musibah yang memilukan seluruh 

manusia di muka bumi ini, tak terkecuali pendidikan. Bahkan saat ini sekolah ditutup dan 

melakukan pembelajaran secara online, tak terkecuali negara indonesia. Krisisnya 

pendidikan yang datang secara tiba-tiba membuat para murid maupun guru merasa 

kesusahan dalam pembelajaran ini. Pembelajaran yang dilakukan tidak lagi dengan tatap 

muka melaikan dengan sosial media saja. 5 

Pembelajaran merupakan suatu keadaan dimana seseorang melakukan cara untuk 

mencapai suatu ilmu, keterampilan dan hal-hal yang positif dengan pemanfaatan beraneka 

ragam sumber untuk belajar. Pembelajaran dapat melibatkan dua pihak yaitu peserta didik 

dan guru sebagai fasilitator,pembelajaraan yang baik terkadang dikaitkan dengan adanya 

fasilitas yang baik dan memadai belum tentu memiliki guru yang kratif dan inovatif, guru 

tekadang memiliki keterbatasan dalam mengolah informasi dan juga mempresentasikan 

konsep materi terutama pembelajaran yang bersifat abstrak di dalam kelas,masih banyak 

ditemui guru dalam penyampain pembelajaran masih kovesional, dimana masih banyak 

guru yang tidak memanfaatkan media baru dalam saran pembelajaran dikelas,sehingga 

para murid menjadi jenuh dan mengantuk saat pembelajaran di lakukan. 6  

Dengan adanya guru yang mempunyai kreatifitas inovatif yang tinggi dan memahami 

teknologi pembelajaran akan teasa menyenangkan7. Pembelajaran media yang cocok dan 

menarik akan membagikan dampak bagi siswa dalam memahami materi yang disampaikan 

oleh guru, dalam hal ini media pembelajaran berupa audio dengan fitur yang canggih 

merupakan salah satu cara yang dapat digunakan dalam mempertinggi kemampuan siswa 

sehingga para murid menjadi lebih antusias dalam belajar dan memahami pembelajaran. 

 
1 C. H. M. Versteegh and Mushira. Eid, Encyclopedia of Arabic Language and Linguistics (Brill, 

2009). 
2 Ayu Fitria, Ayu Fitria : Penggunaan Media Audio Visual PENGGUNAAN MEDIA AUDIO VISUAL 

DALAM PEMBELAJARAN ANAK USIA DINI. 
3 Muhammad Hasan and Muhammad Azis, Pembangunan Ekonomi & Pemberdayaan Masyarakat: 

Strategi Pembangunan Manusia Dalam Perspektif Ekonomi Lokal, CV. Nur Lina, 2018. 
4 André Gide, ‘済無No Title No Title No Title’, Angewandte Chemie International Edition, 6(11), 

951–952., 1967, 5–24. 
5 Al-Ihwanah Al-Ihwanah, ‘Implementasi E-Learning Dalam Kegiatan Pembelajaran Pgmi Iain 

Sulthan Thaha Saifuddin Jambi’, Cakrawala: Jurnal Studi Islam, 11.1 (2016), 76–91 

<https://doi.org/10.31603/cakrawala.v11i1.102>. 
6 Siti Zubaidah, ‘Keterampilan Abad Ke-21: Keterampilan Yang Diajarkan Melalui Pembelajaran’, 

Seminar Nasional Pendidikan, 2.2 (2016), 1–17. 
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Pada hakikatnya dunia ini diliputi oleh berbagai macam bahasa. Bahasa merupakan 

suatu alat komunikasi yang diucapkan dan menghasilkan bunyi dan suara sehingga orang 

paham terhadap apa yang kita ucapkan 7. Bahasa ini mempunyai beragam sifat, baik yang 

bersifat nasional maupun internasional 8. Jadi, kita tidak hanya memahami bahasa nasional 

saja, akan tetapi alangkah baiknya kita juga memahami bahasa internasional, salah satunya 

adalah bahasa arab 9. Bahasa dapat diartikan sebagai alat komunikasi yang dapat 

mempermudahkan kita untuk berinterksi dimana pun kita berada, sehingga dengan 

bayaknya bahasa yang kita miliki, dapat mempermudahkan kita berada dengan siapapun 

dan dimanapun 10. Salah satu bahasa yang harus kita pelajari dan yang termasuk kedalam 

kurikulum di sekolah sekolah yaitu bahasa arab. Bahasa arab adalah suatu kalimat yang 

dominan diucapkan oleh orang arab itu sendiri, untuk menyampaikan maksud dan 

tujuannya kepada orang lain, sehingga orang tersebut dapat memahami terhadap yang kita 

ucapkan 11. Bahasa Arab memiliki keistimewaan dengan bahasa lainnya, sebab nilai sastra 

yang bermutu tinggi bagimereka yang mendalaminya serta bahasa Arab juga ditakdirkan 

menjadi bahasa al-Qur’an yg mengkomunikasikankalam Allah. karena pada dalamnya 

terdapat uslub bahasa yang indah bagi manusia serta tak terdapat seorangpun yang mampu 

menandinginya 12.Bahasa Arab dan al-Qur’an adalah kesatuan yang tak mampu dipisahkan 

satu dengan yang lainnya. Dalam belajar al-Qur’an bahasa Arab adalah kondisi mutlak 

yang harus dikuasai, demikian halnya dengan belajarbahasa al-Qur’an berarti belajar 

bahasa Arab. Bahasa Arab termasuk galat satu pada antara bahasa yang banyakdigunakan 

pada dunia, karena banyak yang menggunakannya, maka bahasa Arab ini sebagai bahasa 

Internasionaldandiakui oleh global 13. 

Kemahiran yang harus dimiliki dalam pembelajaran bahasa arab meliputi empat 

keterampilan, yaitu maharah kitabah, yang mana dalam maharah kitabah ini terdapat 

keterampilan dalam menulis yang diperoleh melalui pola pikir kita serta gagasan yang 

dapat dikembangkan dalam suatu buku atau lainnya 14. istima’ ini adalah kemampuan 

dalam mendengar penjelasan materi yang disampaikan oleh pendidik, pada maharah 

istima’ ini media interaktif sangat berfungsi dalam pembelajaran istima’ ini 15. 

Maka dari itu, tujuan dari penelitian ini adalah untuk menawarkan kemungkinan 

penggunaan audio sebagai alternatif pembelajaran. Dengan audio sebagai medianya 

seorang pengajar dapat mengenfisiensiakan kegiatan belajar mengajar. Oleh karena itu 

diperlukan keterbukaan untuk menerima teknologi baru dan menggunakannya dengan 

bijak. Dengan metode ajar audio hanya diproduksi sekali untuk beberapa kali pertumuan. 

Selain itu, penelitian ini akan menjadi tawaran pembelajaran yang mengasilkan bagi siswa-

siswi. 

 
7 Dr. Dadan M.Pd Suryana, ‘Dasar-Dasar Pendidikan TK’, Hakikat Anak Usia Dini, 1 (2007), 1–65. 
8 Kata Kunci, ‘Penumbuhan Semangat Kebangsaan Untuk Memperkuat Karakter Indonesia Melalui 

Pembelajaran Bahasa’, Jurnal Pendidikan Karakter, 0.3 (2013). 
9 M Khalilullah and SAg MA Dosen Fakultas Tarbiyah dan Keguruan UIN Suska Riau, PERMAINAN 

TEKA-TEKI SILANG SEBAGAI MEDIA DALAM PEMBELAJARAN BAHASA ARAB (MUFRADAT). 
10 Khalilullah and Dosen Fakultas Tarbiyah dan Keguruan UIN Suska Riau. 
11 Dosen Fakultas and others, PROBLEMATIKA PEMBELAJARAN BAHASA ARAB Oleh: Nandang 

Sarip Hidayat. 
12 Jurnal Pendidikan, Bahasa Arab, and Dan Kebahasaaraban, Pembelajaran Bahasa Arab : 

Problematika Dan Solusinya. 
13 Qomi Akid Jauhari Dosen Tetap UIN Maulana Malik Ibrahim Malang, PEMBELAJARAN 

MAHARAH ISTIMA DI JURUSAN PBA UIN MAULANA MALIK IBRAHIM MALANG, 2018, III. 
14 Khoirotun Ni’mah, ‘Khat Dalam Menunjang Kemahiran Kitabah Bahasa Arab’, DAR EL-ILMI: 

Jurnal Studi Keagamaan, Pendidikan, Dan Humaniora, 6.2 (2019), 263–84. 
15 Akid Jauhari Dosen Tetap UIN Maulana Malik Ibrahim Malang, III. 
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METODE 

Metode penelitian yang digunakan berupa metode kualitatif yang bersifat deskriptif 

dan cenderung menggunakan analisis 16. Analisis yang digunakan bertujuan untuk 

membandingkan aplikasi yang digunakan untuk pembelajaran bahasa arab khususnya 

istima’ 17. Menganalisis bagaimana audio di produksi dan terdengar nyaman bagi siswa-

siswi dan para siswa tidak merasa jenuh akan pembelajaran dengan menampilkan berbagai 

macam daya tarik dari suatu aplikasi dan efek-efek semenarik mungkin 18. 

Penelitian ini sangat sederhana yaitu dengan cara mewawancarai salah satu guru 

bahasa arab di MTsN 10 Tanah Datar untuk mengakses pembelajaran secara auditif dan 

refetitif. Langkah-langkah yang digunakan dalam penelitian ini berupa pengumpulan data 

yang telah diteliti di madrasah tersebut serta menjelaskan menu-menu yang ada dalam 

aplikasi audasicity, serta bagaimana cara menggunakan aplikasi audacity pada 

pembelajaran mahara istima’ di MTsN 10 Tanah Datar kelas VII 19.  

HASIL DAN PEMBAHASAN 

Media merupakan bagian integral dalam pembelajaran dengan menggenakan media 

pembelajaran yang sesuai dengan karakteristik materi pembelajaran dan karakteristik 

siswanya, maka pembelajaran akan lebih bermakna dan mendapatkan hasil yang 

dikehendaki 20. 

Media audio merupakan sebuah tawaran metode pembelajaran yang masih belum 

banyak dilirik dan dioptimalkan oleh para tenaga pendidik dan pendidikan. Saat ini metode 

pembelajaran masih sebatas sosial media berupa WhatsApp, classroom dan media sosial 

lainnya 21. Sedangkan pendidikan tersebut merupakan suatu proses dimana adanya 

hubungan timbal balik antara dua orang yaitu guru dan murid dalam menimbang suatu 

ilmu dan dengan ilmu tersebutlah yang akan menjadi bekal dimasa depan 22. 

Media dan instrument pembelajaran memiliki dampak pada membantu pengajar 

mendemonstrasikan bahan atau bahan ajar pada peserta didik sehingga membangun proses 

belajar mengajar yang efektif dengan kata lain media dipergunakan dengan tujuan 

membantu guru agar proses belajar siswa lebih efektif serta efisien23. Fasilitas belajar yang 

tersedia dalam jumlah memadai di suatu sekolah memiliki pengaruh terhadap 

 
16 Suliyanto, ‘Pelatihan Metode Pelatihan Kuantitatif’, Journal of Chemical Information and 

Modeling, 5.2 (2017), 223–32. 
17 Hamidah Hamidah and Marsiah Marsiah, ‘Pembelajaran Maharah Al-Istima’ Dengan 

Memanfaatkan Media Youtube: Problematika Dan Solusi’, Al-Ta’rib : Jurnal Ilmiah Program Studi 

Pendidikan Bahasa Arab IAIN Palangka Raya, 8.2 (2020), 147–60 

<https://doi.org/10.23971/altarib.v8i2.2282>. 
18 Giandari Maulani, Sugeng Widada, and Nabila Geysaka Amir, ‘Media Sistem Informasi Video 

Profile SMA Permata Insani Menggunakan Adobe Creative Cloud’, SENSI Journal, 6.1 (2020), 24–37 

<https://doi.org/10.33050/sensi.v6i1.937>. 
19 Bhalla Prem, ‘Tatacara Ritual Dan Tradisi Hindu. (Surabaya: Paramita, 2010).’, Paramita, 3.1 

(2017), 78–95. 
20 Novera Marbun, ‘Related Papers’, Over The Rim, 2017, 191–99 

<https://doi.org/10.2307/j.ctt46nrzt.12>. 
21 Ahmad Fujiyanto, Asep Kurnia Jayadinata, and Dadang Kurnia, ‘Penggunaan Media Audio Visual 

Untuk Meningkatkan Hasil Belajar Siswa Pada Materi Hubungan Antarmakhluk Hidup’, Jurnal Pena Ilmiah, 

1.1 (2016), 841–50 <https://doi.org/10.23819/pi.v1i1.3576>. 
22 A Agustyan, ‘Pemikiran Pendidikan Karakter Menurut Azyumardi Azra Dan Implikasinya Dalam 

Pembelajaran Di Lembaga Pendidikan Agama Islam Indonesia’, 2021. 
23 Ansori, ‘PROBLEMATIKA PEMBELAJARAN TEMATIK INTEGRATIF DI MIN 

BONDOWOSO (Studi Multi Kasus MIN Lombok Kulon Wonosari Bondowoso Dan MIN Locare Curahdami 

Bondowoso)’, Journal of Chemical Information and Modeling, 53.9 (2016), 1689–99. 
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keberlangsungan proses belajar-mengajar. Tanpa ada fasilitas belajar yang tersedia dalam 

jumlahyang memadai di sekolah, proses interaksi belajar-mengajar kurang dapatberjalan 

secara maksimal dan optimal 24. 

Jika para pendidik dan pendidikan mengguanakan media audio mendapatkan 

beberapa keuntungan, yaitu (1) Audio yang memiliki sifat auditif akan bekerja merangsang 

indera pendengaran yang mungkin seringkali diabaikan karena kita sudah tertebiasa 

dengan materi-materi ajar yang bersifat visual. (2) Audio memiliki durasi bertahan yang 

cukup lama, proses produksinya hanya sekali tetapi dapat didengarkan bekali-kali. (3) sifat 

audio sangat fleksibel, audio tidak membutuhkan ruang penyimpanan yang besar. Materi 

yang di ajarkan bisa didengarkan dimana saja. (4) bahkan seorang tuna rungu dapat belajar 

dan mengakses pengetahuan menggunakan media audio 25. 

Mahara istima’ merupakan pembelajaran yang sering menggunakan media audio. 

Hal ini dikarenakan pembelajaran ini berupa publik speaking sehingga siswa-siswi wajib 

mendengarkan materi yang diputar oleh guru. Bahkan para tenaga pendidik menggunakan 

audio dan ditambah dengan beberapa fitur berupa gambar-gambar yang ditampilkan untuk 

menarik perhatian para siswa-siswi agar siswa-siswi tidak merasa bosan. 

Audio selalu mengikuti dimana visual berada. Bahkan, audio juga memberi peran 

bagi manusia berupa pendidikan 26. Kebutuhan manusia akan adanya pendidikan dan 

pengetahuan semakin hari makinperlu lebih fleksibel dan tetap akurat. Dunia pendididkan 

formal masih tetap perlu berkembang 

Kecenderungan pelajaran saat ini adalah menggunakan media sosial berupa youtube, 

google, telegram, whatsapp, classroom dan lainnya. Beberapa konten yang beredar 

memberikan pengetahuan yang benar, namun tidak sedikit konten yang diberikan sangat 

instan, atau bahkan salah dalam pengajaran. Pada kepentingan inilah seorang 

pendidik/pengajar perlu ada untuk memberikan kedalaman pemahaman. 

Pada pembelajaran istima’ di MTsn 10 Tanah Datar para guru hanya menggunakaan 

perekam suara lewat handphone lalu disalurkan ke dalam power poin. Guru di MTsN 10 

Tanah Datar ini tekadang juga menggunakan gambar-gambar untuk menarik perhatian 

siswa-siswi meskipun demikian masih banyak siswa-siswi yang masih tidak mengerti 

dengan hal tersebut. Bahkan, guru bahasa arab mengatakan hanya 60% daya tangkap bagi 

semua pelajar. masalah yang sering timbul dari siswa dalam belajar bahasa Arab adalah 

pengalaman dasar latar belakang sekolah, penguasaan mufradhat (pembendaharaan istilah), 

dan dampak dari lingkungan keluarga akibatnya mereka mengalami kesulitan untuk 

memahami bacaan-bacaan serta tidak bisa menguasai bahasa Arab secara utuh baik dalam 

gramatika juga komunikasinya 27. 

Dalam kasus ini para guru juga memutar otak dengan mencari media lain yaitu 

menggunakan audacity. Dalam pengenalan audacity ini pada guru masih bingung 

 
24 Roinah Roinah, ‘Problematika Dalam Pembelajaran Bahasa Inggris Di Stain Bengkalis’, Quality, 

7.1 (2019), 153–66 <https://doi.org/10.21043/quality.v7i1.4966>. 
25 Dwi Agus Diartono, ‘Media Pembelajaran Desain Grafis Menggunakan Photoshop Berbasis 

Multimedia’, Jurnal Teknologi Informasi DINAMIK, XIII.2 (2008), 155–67. 
26 Najmi Hayati and Febri Harianto, ‘Hubungan Penggunaan Media Pembelajaran Audio Visual 

Dengan Minat Peserta Didik Pada Pembelajaran Pendidikan Agama Islam Di SMAN 1 Bangkinang Kota’, 

Al-Hikmah: Jurnal Agama Dan Ilmu Pengetahuan, 14.2 (2017), 160–80 <https://doi.org/10.25299/al-

hikmah:jaip.2017.vol14(2).1027>. 
27 André Gide, ‘Bab 1 Pendahuluan’, Angewandte Chemie International Edition, 6(11), 951–952., 

1967, 5–24. 
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menggunakannya, namun setelah berulang-ulang menggunakan aplikasi ini guru lebih 

mudah menggunakan aplikasi ini 28. 

-Audacity dalam pembelajaran istima’ 

Audacity ini menyediakan fitur-fitur yang menarik, serta kegunaan dalam aplikasi 

audacity tersebut 29. Melalui media ini, proses pembelajaran dapat berjalan secara kreatif 

dan dinamis. Dalam aplikasi ini tentu terdapat kelebihan dan kekuranga, diantaranya 

adalah: 

• Mempermudah dan mempercepat pendidik dalam menyampaikan materi. 

• Aplikasi ini mudah digunakan bagi pelajar. 

• Aplikasi ini menyediakan fitur-fitur yang menarik. 

• Aplikasi ini mudah di akses oleh siapapun. 

• Aplikasi ini gratis.  

• Aplikasi ini menyediakan penyimpanan yang beragam seperti MP3, WAV dan 

OGG.  

Kekurangan dari aplikasi tersebut adalah 

• Proses nya lumayan lama, sehingga dalam proses pengeditan. 

• Di dalam aplikasi ini tidak terdapat video. 

• Bagi pemula tentu sangat sulit karena tidak ada tutorial dalam aplikasi.  

Manfaat audacity untuk pendidik dan peserta didik, yaitu: 

Aplikasi ini merupakan apliksi berbasis teknologi. Audacity ini menyediakan ruang 

dalam pembelajaran.30 Fitur-fitur yang tersedia dalam aplikasi ini menyediakan berbagai 

efek untuk daya tarik peserta didik. Pemanfaatan audio interaktif ini tidak hanya diakses 

oleh pendidik saja, bahkan peserta didik juga dapat mengakses media pembelajaran 

audacity tersebut. Dengan audacity, pendidik juga dapat menginput lagu lagu backsound 

dalam audio tersebut, sehingga penyampaian materi tersebut tidak membosankan. 

Langkah langkah serta manfaat pada aplikasi audacity 

Aplikasi ini dapat digunakan melalui laptop. Cara menggunakan aplikasi ini tidak terlalu 

rumit, sehingga bisa diakses oleh peserta didik dan pendidik. 

Langkah langkah untuk mengakses aplikasi tersebut adalah sebagai berikut: 

1. Downloand aplikasi audacity bisa pada play store dan bisa mengguanakan link di 

bawah ini https://www.audacityteam.org/download/. 

2. Setelah menginstal aplikasi tersebut, maka terbuka tampilan awalnya. di dalam 

aplikasi tersebut terdapat beberapa fitur yaitu transport toolbar yang man isinya 

terdapat beberapa fitur rekaman. lalu ada tools toolbar dimana terdapat selection 

tool ini gunanya untuk menyeleksi track atau audio, evelope tool gunanya untuk 

 
28 Gide, ‘Bab 1 Pendahuluan’. 
29 Nukmatus Syahria and others, PEMANFAATAN TEKNOLOGI DI ERA NEW NORMAL UNTUK 

PEMBELAJARAN SPEAKING DAN LISTENING BAGI GURU-GURU SMA/SMK KOTA SURABAYA, 2021, 

V. 
30 Hanung Nindito Prasetyo Yusuf Ahmadi, Wardani Muhamad, ‘Aplikasi Pembelajaran Cara 

Bermain Gitar Untuk Pemula Berbasis Multimedia’, E-Proceeding of Applied Science, 2.3 (2016), 944–50. 

https://www.audacityteam.org/download/
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memperbesar atau memperkecil track, draw tool gunanya untuk menggambar track, 

zoom tool gunanya untuk membesarkan track, time shift tool gunanya untuk 

mengatur waktu dalam track, multi tool ini merangkup semua fitur-fitur yang tadi 

seperti selction, evelope, draw, zoom, time shift. Meter toolbar gunanya untuk 

mengukur audio kita, mixer toolbar guananya untuk mengukur suara audio dan 

backsound, edit toobar di mana isinya terdapat cut ini berguna untuk memotong 

track yang telah kita seleksi terlebih dahulu, copy gunanya untuk mengcopy track 

yang telah kita selaksi, paste gunanya untuk mengpaste track yang telah di seleksi. 

Meter toolbar gunanya untuk mengatur backsound, play at speed toolbar gunanya 

untuk mengatur cepat atau lambatnya sound yang digunakan. Selain itu terdapat 

efek-efek yang menarik. 

3. Cara awal menggunakan audacity ini untuk pembelajaran adalah merekam materi 

yang akan di ajarkan, setelah itu kita bisa mengedit audio rekaman yang telah di 

sediakan dengan menyeleksi track, kita juga bisa menambahkan backsund pada 

audio dengan cara mengambil dari file, ambil import lalu audio maka akan tampil 

musik yang akan di ambil. 

4. Jika sudah maka kita bisa menyimpannya. Dengan cara tekan file lalu ambil ekspor 

maka nantik kita akan diberi pilihan berupa MP3, WAV dan OGG 31. 

Fitur-fitur yang ada didalam Audacity. 

1.Audacity interface 

As one of the free sound editing tools, Audacity has full features for simple to intermediate 

editing. Here's what the Audacity interface looks like. 

 

Menu  

 
31 Zaid Romegar Mair, ‘BAHAN AJAR BERBASIS MULTIMEDIA MATA KULIAH 

PRAKTIKUM SISTEM OPERASI PROGRAM STUDI TEKNIK INFORMATIKA POLITEKNIK 

SEKAYU’, Jurnal Teknik Informatika Politeknik Sekayu (TIPS), VII.2 (2017), 24–32. 
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At the very top there is a menu bar, where in File there are options to create a new file, 

open a past project, import audio files, and manipulate metadata. The important thing to 

note is Generate and Effect, because in these 2 tabs there are features that are most often 

used in audio editing. 

Playback Buttons 

Pause, play, stop, skip to start, skip to end, and record. 

Navigation Tools 

A set of tools for selecting, Selection tool for highlighting certain areas, Envelope tool for 

adjusting the height of the graphic. The draw tool is used to edit each sample point. Time 

shift is used to shift the location of the sound relative to time. 

Levels 

Incoming or outgoing sound power level in db. In digital format the greatest power that 

can be rendered is 0 db. 

Input Output Devices 

If there is more than one input device, you can select which device to use for playback or 

recording. If when recording through the microphone, no sound is detected, check this 

section again. 

2. Audacity File Formats 

In doing editing, Audacity saves the edited file in the Audacity Project file indicated with 

the.aup extension. This file cannot be used by other applications and besides saving the 

waveform of the currently opened sound, it also stores other information that only 

Audacity can read. 

To save edits in other formats, you can use the Export function. Export will save all 

changes that have been made in a standard format such as wav or mp3. 
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3. Recording 

To make a recording, press the button on the playback buttons. In recording, what needs to 

be considered is the level of the mic input. If it exceeds the limit, there will be noise / 

crackling. If this happens lower the volume from the input. 
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4. Cut, Trim, and Silence 

The waveform and timeline display in Audacity makes it easy for us to do sound editing, 

almost the same as image editing, Audacity makes edits based on selection. Use the 

Selection tool to make a selection. So that the selection can be done with precision, 

Audacity can zoom in and zoom out so that the selection can be done in a fraction of a 

second. 

The Trim function will cut the selected part and remove the rest of the unselected audio 

clip. While Cut will cut the selected part and reconnect the cut audio. To remove unwanted 

noise between each word use Silence Audio. 

5. Effects 

Audacity provides a lot of sound effects that can be directly applied to audio clips. 

5.1 Change Pitch 

To use the desired effect, you must select the part where the effect will be applied. Each 

effect has its own settings that can be adjusted as needed. To change the male voice to 

female voice or vice versa can use the Change Pitch effect. 

 

. 5.2 Change Tempo 
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To speed up or slow down playback without changing the sound characteristics, you can 

use change tempo 

 

5.3 Noise Removal 

Further in using the Effects feature is noise removal. To remove noise in the sound 

recorded by the microphone, Audacity provides a Noise Removal tool. The most important 

element in noise removal is getting a sample of the noise itself, so Audacity can figure out 

which parts to remove. 

To get a noise sample, record with the mic and let the recording run for a few seconds 

before finally starting to record sound. Then do the selection at the beginning when the mic 

is already recording but you haven't started talking. 
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After the get noise sample button is pressed, the noise removal window will disappear, but 

the noise sample profile has been saved, so go back to the workspace and make a selection 

on the area to be filtered. Then go back to Effects -> Noise Removal. The greater the noise 

reduction (dB) number, the more aggressive Audacity will be in filtering noise with the risk 

that the sound that does not want to be filtered will also be lost. 

 

Keep the Frequency value at 1000 Hz, and select a Rolloff value of 6B, then click OK. 

After that go to Effect -> Low Pass Filter. 

 

Select Rolloff 12 dB and click OK. 

After both effects are applied, your recording will sound softer, so use Effect -> Amplify to 

restore the volume. 
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5.5 Reverse & Reverb 

Reverse and combined with reverb will produce a unique sound that makes it seem as if the 

sound comes out of another world. This effect can be applied by selecting the part of the 

sound to be manipulated, then going to Effect -> Reverse. 

 

After that go to Effect -> Reverb and as an experiment, leave the default values then press 

OK. 

 

After that, return the audio to the initial position with Effect -> Reverse. 

Kita juga bisa membah daya tarik siswa dengan cara berikut: 

Memasukan arsip Ke Audacity 

1. Open the Audacity software 

2. Click the file then open or you can also use the Drag System (Drag the MP3 file to 

the application), if it's not mp3, try converting the sound file to mp3 using a free 

audio converter or other software 
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Menghapus Bagian tertentu pada arsip suara 

1. Open the Audacity software 

2. Click the file then open or you can also use the Drag System (Drag the MP3 file to 

the application), if it's not mp3, try converting the sound file to mp3 using a free 

audio converter or other software 

Menggabung-gabungkan arsip Musik 

If we want to combine music archives, as a result, the music played continues so that it 

is longer or is combined into play at the same time, we can do this by 

1. Open the sound file that we want to open as the first sound (drag or open) 

2. Drag the sound file of the next music (don't open it), then place it at the end of the 

end of the first music If you want to continue playing, or under the primary file If 

you want to merge it into a background (play together) 

3. If the second music is even below the first music (even though we want the end of 

the first music). We can block all the second music and then select Copy. then go 

back to the end of the first music (click), then paste it there. 

Memberi bunyi Backround Musik pada arsip bunyi Rekaman 

1. Open the sound archive of Our Recorded Music (must file with mp3 extension). If 

it's not mp3, try converting it to mp3 with free audio converter software or other 

software 

2. Drag the Music file that will be used as a Background and place it under the main 

music file 

3. If you want to shift Music to the right or to the left, use the Time Shift Tools. 

Memperbesar bunyi akibat Rekaman 

If the sound of the recording we want is too small, even though the volume of the 

player and speaker is full. we can try to edit the music sound files that my friends have 

bigger using this application. 

1. Open the music sound file that we want to edit (already mp3) 

2. Notice the Left above L and R 

3. Increase the sound of the music using Swipe Towards Plus or negative. 

4. Adjust the Volume In and Out 

If we want to edit so that the first incoming sound sounds small and then gets bigger, 

we can use Fade In. Or adjust the sound at the end of the music to get smaller, you can 

use Fade Out. 

1. Open the Music sound archive that we want to edit (already mp3) 

2. Select an Area using the Selection Tools 

3. Click Effect then Select Fade In or Fade Out 

4. Exporting files as a result of Edit 

If we have finished editing the music archive we have. We can save the results through 

the archive menu, then save it as an mp3 file or other type. 

Select Export, then select the archive type (mp3, amr, etc). don't forget to select the 

kbps quality that will be entered in the options menu. 
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Or save the project if our work has not been completed32. 

KESIMPULAN  

Media audio merupakan sebuah tawaran metode pembelajaran yang masih belum 

banyak dilirik dan dioptimalkan oleh para tenaga pendidik dan pendidikan. 
Media dan instrumen pembelajaran mempunyai efek pada membantu guru mendemonstrasikan 

bahan atau bahan ajar kepada siswa sebagai akibatnya membangun proses belajar-mengajar yang 

efektif dengan kata lain media dipergunakan dengan tujuan membantu pengajar agar proses belajar 

siswalebih efektif dan efisien. Fasilitas belajar yang tersedia pada jumlah memadai pada suatu 

sekolah mempunyai pengaruh terhadap keberlangsungan proses belajar-mengajar. Jika para 

pendidik dan pendidikan mengguanakan media audio mendapatkan beberapa keuntungan, 

yaitu (1) Audio yang memiliki sifat auditif akan bekerja merangsang indera pendengaran 

yang mungkin seringkali diabaikan karena kita sudah tertebiasa dengan materi-materi ajar 

yang bersifat visual. (2) Audio memiliki durasi bertahan yang cukup lama, proses 

produksinya hanya sekali tetapi dapat didengarkan bekali-kali. Mahara istima’ merupakan 

pembelajaran yang sering menggunakan media audio. Audio selalu mengikuti dimana 

visual berada. Kebutuhan manusia akan adanya pendidikan dan pengetahuan semakin hari 

makinperlu lebih fleksibel dan tetap akurat. Kecenderungan pelajaran saat ini adalah 

menggunakan media sosial berupa youtube, google, telegram, whatsapp, classroom dan 

lainnya. Beberapa konten yang beredar memberikan pengetahuan yang benar, namun tidak 

sedikit konten yang diberikan sangat instan, atau bahkan salah dalam pengajaran. Pada 

pembelajaran istima’ di MTsn 10 TANAH DATAR para guru hanya menggunakaan 

perekam suara lewat handphone lalu disalurkan ke dalam power poin. Guru di MTsN 10 

TANAH DATAR ini tekadang juga menggunakan gambar-gambar untuk menarik 

perhatian siswa-siswi meskipun demikian masih banyak siswa-siswi yang masih tidak 

mengerti dengan hal tersebut. 

Perkembangan teknologi yang semakin pesat memudahkan para guru dalam belajar 

salah satunya pembelajaran istima’. Dalam pembelajaran ini sangat dibutuhkan audio 

sebagaimana dalam pembelajarannya menggukan pancra indera pendengaran siswa di latih 

untuk fokus mengenal mufradat yang di dengar dan merangsang otak dalam berfikir.hal ini 

membutuhkan aplikasi perekam suara, audacity salah satunya. Aplikasi menyediakan fitur-

fitur menarik yang akan membuat para siswa tidak dilanda kebosanan apalagi ditambah 

dengan backsound, hal ini menambah daya tarik tersendiri dalam pembelajaran istima’. 

Bukan hanya guru yang dapat menggunakan aplikasi ini, murud juga bisa mengguankan ini 

karena aplikasi ini gratis dan dapat di jangkau di manapun. Meskipun aplikasi ini banyak 

keunggulannya pasti ada kelemahannya yaitu aplikasi ini tidak dapat di instal di handphone 

meskipun bisa maka harus mempunyai penyimpanan yang tinggi. 
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